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Introduction to ForexGridMaster Express
ForexGridMaster goes beyond the normal limits of MetaTrader 4 from MetaQuotes, and is built with Industrial

Strength code to put it on the leading edge of automated Forex trading.  It truly is the Rolls Royce of grid trading
systems.

ForexGridMaster Express EA (Expert Advisor) was developed to enable traders to design and trade any number
of their own automatic trading system strategies, as well as those created and shared by others.  All ForexGM
Express input settings are documented and easily configured by the trader.  ForexGM was primarily designed as a
tool to develop and fine-tune algorithmic grid trading strategies that profit from price movements, small or large, in
either direction -- trend, counter-trend, range, scalping, news, or breakout trading.  ForexGM is also very versatile
for precision semi-automatic manual trading, especially scalping.   We are open to your ideas and adding new
features to ForexGM that  promise higher and safer profits.   Sample strategies and results  are posted on the
Performance Page of the ForexGM web-site.   Optimization Reports with viewing and download links for some
preset strategy files are provided for sharing at FORO (ForexGM Optimization Reports Online).  Please note that
these links refer to results from earlier versions of ForexGM.

Matching specific ForexGM strategies with the most appropriate brokers can make a big difference to your
bottom-line, especially for scalping strategies.  We have traded with more than twenty brokers since 2002, and the
choices continue to improve in favour of traders.  Brokers are becoming more competitive, traders more aware, and
regulatory agencies more watchful.  Now it is the norm to expect low spreads (1 pip or less for EURUSD), no or low
commissions, no re-quotes, instant execution,  no trade restrictions such as pending order distance from current
price, 0-1 pip stop loss, 1 ms to 10 ms (or less) latency from VPS to broker server, etc.  These are all important
aspects of Forex to learn and use to your advantage.

ForexGridMaster Express is user-friendly, and is also a very sophisticated software program with many options
that require time and practice for a user to fully appreciate all the possibilities.  Be warned that the vast number of
combined settings with endless scenarios that result, may trigger a lot of brain-storming and fun.  Gamers, take
note.

The  contents  of  this  document  are  purely  for  educational  purposes  and  should  never  be  considered  as
investment advice.  ForexGridMaster.com, its owners, staff, affiliates and associates, are not liable for loss or
damage of any kind which may arise directly or indirectly from the trading or use of any of the offerings from
ForexGridMaster.com, including  Expert Advisor robots and all related information and material.
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ForexGridMaster User Guidelines

ForexGM Latest Build:

At the time of writing, the current version of ForexGM Express is v6.01 build 44.  It will run on MetaTrader 4.00
build 1090 and above.

ForexGM Licensing:

ForexGM Express (full version) is licensed to a trader’s Account-Name, allowing up to 3 real-money accounts
and 5 demo-accounts.  ForexGM Express trial-version only works on demo-accounts.  If any License changes are
required, these can be made by logging into your account at EAfactory.

Account Currency and Normalization:

ForexGM can trade any Account-Currency... USD, EUR, GBP, JPY, CHF, AUD, etc.  ForexGM also integrates
conversion-pair  currency calculations (Normalization).   This enables more accurate results when using different
Account-Currencies trading the same strategy and same currency-pair on demo and real money accounts, or in
Strategy  Tester.   MetaQuotes  does not  yet  acknowledge this  issue  and consequently  Strategy  Tester  results
without Normalization can sometimes be inaccurate.  For example, when trading AUDNZD using a USD Account-
Currency, the NZDUSD is the conversion-pair (ratio of Account-Currency USD to the NZD Quote-Currency).

This means that in Strategy Tester the M1 historical data must be loaded for NZDUSD as well as AUDNZD so
that ForexGM Express Normalization can provide the most accurate back-testing results.  In Strategy Tester, the
NZDUSD price action is displayed on the bottom right of the chart.  Same example but on a real money account,
the  NZDUSD  must  also  be  listed  in the  Market  Watch  panel so  that  ForexGM  will  integrate  the  NZDUSD
conversion-pair price action in real time as well.   Trading AUDNZD with NZD as the account-currency does not
require conversion, and when trading AUDNZD with AUD as the account-currency, the conversion-pair is AUDNZD
itself.

Decimal Places and Pips:

ForexGM Express automatically detects whether the broker uses 2, 3, 4 or 5 decimal places for price quotes.  As
an example, Take-Profit Pips can be set to 17 pips regardless of whether the price quotes use 2, 3, 4 or 5 decimal
places.  In the case of the EURUSD as one example of 5th place decimal pricing, the 4th place decimal is the pip
and the 5th a fraction of a pip (called a point).  If the EURUSD moves from 1.37010 to 1.37020, then it has moved 1
pip or 10 points.  If it moves from 1.37010 to 1.37011, then it has moved 1/10th of a pip or 1 point.  For currency-
pairs with 3 decimal places, such as the USDJPY, if the price moves from 95.700 to 95.710, then it has moved 1 pip
or 10 points, and if from 95.700 to 95.701, then it has moved 1/10th of a pip or 1 point.

For trading instruments like Stocks, CFDs or crypto-currencies, the concept of a “pip” is less well defined.  When
dealing with anything other than Forex, ForexGM normally treats a pip as 1 unit of quote currency – e.g. BitCoin
quoted in US dollars would use 1 pip = US$1.

Settings Changes:

When starting a new strategy or making major changes to an existing one beyond small variations to settings
that can be changed on-the-fly,  it  is  best to rely on the philosophy, “New Strategy >> New Chart”.   Removing
ForexGM from an  old  chart  is  ULTRA important  because  it  clears  the  Global  Variables  associated  with  that
particular strategy on that particular chart.  To close associated trades, use the MT4 "One-Click Trading Mode" for
fast delete of trades or perhaps the CloseAllNow option if the ForexGM EA is still functional on the chart.        

Time-Frames:

ForexGM Express strategies are not time-frame dependent, meaning that any ForexGM strategy can be traded
on any time-frame and the only difference will be how well the trading action can be viewed.  We recommend using
ForexGridMaster on the M1 time-frame for maximum visibility, and switch time-frames as desired since this will not
disrupt normal ForexGM function.  Pending orders and open trades will also display on other charts using the same
currency-pair.                              .   

Leverage:

Some brokers will allow as much as 1:500 leverage or more on their accounts. This means that ForexGM can
trade a full standard lot of $100,000 using only $200 on margin, which is excellent for ForexGM, especially when
trading for high profit.   Most grid-trading strategies need a healthy margin for flexibility,  especially for Portfolio
trading.  The leverage on the account that ForexGM is trading can be seen in the Experts log-file, usually a line or
two after ForexGM has been initialized.  High leverage can be dangerous if a trader is not experienced and well
aware of potential negative consequences when setting strategies and managing money.
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Closing Orders:

Whenever many open or pending orders are triggered to close at the same time by Close-Run settings, it takes
time for the open trades and pending orders to all close.  Price is moving continuously, so the closing prices will not
always be exactly those requested.  In normal market conditions, the difference is usually relatively small.

Many Simultaneous Transactions:

The more open-trades and pending-orders there are on an active chart,  the greater the chance of delayed
execution, especially if the latency of trade execution is more than 50 milliseconds.  Also, not all brokers are the
same.  There are many levels of technology involved -- the broker and their server, their MetaTrader environment,
the computer that ForexGM Express trades from, Internet connection, VPS environment, bank-feeds to the broker,
etc.  MetaTrader4 executes only one line of code at a time per chart, and although infrequent, glitches can occur,
and it is important to keep a watchful eye until reliability has been proven.

We strongly recommend that all  ForexGM strategies be first traded on a demo-account, and also back and
forward-tested using Strategy Tester with at least 2 year's tick-data.  This will allow the trader to become familiar
with the large number of ForexGM settings and how they combine to produce effective and profitable strategies.
Best to start small when trading a real-money account.  MetaTrader brokers are not all equal, and different brokers
may produce  different  results  because  of  certain  parameters  they  have  set  for  their  environment.   However,
ForexGM Express is capable of trading reliably on most broker platforms for an indefinite period of time.

ForexGM EA Smiley-Face:  

While ForexGridMaster is active and able to successfully transact with the broker's server, a small smiley-face
icon  displays  at  the  top  right  of  the  chart  window.   Click  on  that  icon  to  open  ForexGM’s  properties  panel.
Alternatively, right-click in any clear area of the chart and in the pop-up panel that shows, choose “Expert Advisors
> Properties”.   If  an emergency situation arises and ForexGM cannot  be accessed through property  settings,
clicking the AutoTrading button on the top toolbar will  disable ForexGM.  Note that the AutoTrading button will
disable all EAs currently attached to charts in the terminal, not just the EA on the active chart.  A subtle change in
the button-image indicates its status, and, because of its importance, ForexGM also displays additional information
to alert the trader when trading is not permitted.  If all else fails, simply close the chart window and any open trades
and pending orders might need to be closed or deleted manually.  When ForexGM is inactive, the smiley-face turns
red to indicate some user intervention may be required.

Preset Strategy Files:

When creating strategies for ForexGM Express using the input settings described below, they can be saved as
preset files in the “[MT4 Data Folder]\MQL4\Presets” default directory, or “[MT4 Data Folder]\tester” directory when
using the Strategy Tester.  To use a particular set-file for trading or testing, open ForexGridMaster on a chart and
then “Load” the preset file from the “Inputs” tab.  ForexGM preset files can also be saved and shared with others.  It
can be useful to name preset files to identify key elements of the strategies to which they relate.

As  an  example,  a  set-file  could  be  named  “audnzd_bsct5-s0.05_lsp0.015-ip16.2_tp21_m990-3_crppbts0.3-
ts0.0001_ce25-us100k.set”.  This file would refer to a Buy-Sell Counter-Trend strategy for trading the AUDNZD pair
with Grid Spacing = 5 pips, Grid Spacing Step = 0.05 pips, Lot-Size(Proportional) = 0.015, Lot-Size Increase
Percent = 16.2, Take-Profit Pips = 21, CR Profit Percent Before TS = 0.3 with CR Trail-Stop Percent = 0.0001
and works best trading at least $25,000 Chart-Equity of US $100,000 Account-Currency.  This might seem quite
long-winded, but for a large number of strategies, it could be worth the effort.

Sharing Strategies:

Preset “.set” files can be shared directly with other traders, or online using the FORO system.  Our hope is to
have many traders creating, back-testing and optimizing reliable winning strategies for all to share.

Back-Testing:

For back-testing ForexGM, use the M1 time-frame (Tick-data) to obtain the most accurate and reproducible
results.  In the Tools > History Center menu, select Currency-Pair > 1 Minute (M1) and click “Download” to load the
data from MetaQuotes into the terminal.  Trading a real-money account without having done any back-testing is
certainly not recommended.  However,  be aware that the history-data downloads for some currency-pairs from
MetaQuotes are not always accurate and complete.

The MetaTrader 4 Strategy Tester is known for its peculiarities, not the least of which is the way it interprets
Spread values.  Theoretically, Spread is specified in “Points”, which should refer to the least-significant digit in the
quoted price.  Some brokers offer trading in crypto-currencies, and this can result in very high Point values for
Spread causing the Tester to behave unpredictably.  Best method to check if a chosen Spread is realistic is to set
both Bid and Ask lines visible on the test chart, and compare those with the Bid-Ask lines shown on an active chart.
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ForexGridMaster Input Settings Summary
These trader input settings listed here are linked to their detailed descriptions below.  The value shown  for each

setting corresponds to the default setting in ForexGM at the time of writing.  The AUDNZD default strategy is  for
demonstration purposes only, but can be traded as is on the AUDNZD and also the NZDCAD and AUDCAD with
minor adjustments.  When correctly installed, ForexGM Express EA robot will show in the Experts folder on the
Navigator panel, which is normally displayed on the left side of the MetaTrader4 terminal.  Drag and drop the robot
on the chart with the currency-pair you want to trade, and the Properties panel will open allowing modification of any
of the settings listed below.  When set as desired, click the OK button and the ForexGM strategy will start trading
Run 1 on arrival of the next tick from the broker's server.

GENERAL CHART SETTINGS

  EA Number 62528
  Strategy File e6_audnzd_bsct5-s0.05_lsp0.015-ip16.2_tp21
  Strategy Info sp.0001-ip12_tp13-s0.2_crppbts0.6-ts0.1
  Chart Equity Percent 50
  Grid Type ( Fixed-Center-Grid; Moving-Center-Grid )

GRID GENERAL INPUTS

  Order Type ( Buy-Sell; Buy-Full; Sell-Full; Buy-Half; Sell-Half )
  Trend Direction ( Trend; Counter-Trend )
  Grid Spacing 5
  Max Pending Buy Orders 1
  Max Pending Sell Orders 1
  Max Open Buy Trades 60
  Max Open Sell Trades 60
  Center-Zone Pips 0
  Grid Order Replacement true
  Open At Current Price ( Not-Used; Buy-Order; Sell-Order )

GRID ORDER INPUTS

  Lot-Size 0.015
  Lot-Size Scaling ( LotSize-Constant; LotSize-Proportional )
  Take-Profit Pips 21
  Stop-Loss Pips 0
  Break-Even Stop (BES) false
  Profit Pips Before BES 0
  Break-Even Stop Plus Pips 0
  Trail-Stop Pips (TS) 0
  Profit Pips Before TS 0
  Max Order-Period 990
  Max Order-Frequency 3 

GRID FIXED-CENTER INPUTS

  Grid-Spacing Step 0.05
  Grid-Increment Percent 0.0
  Lot-Size Increase Amount 0.0
  Lot-Size Increase Percent 16.2
  Lot-Size Increase Fibonacci false
  Take-Profit Pips Step 0.0

GRID MOVING-CENTER INPUTS

  Moving-Center Buy-Sell Overlap false
  Moving-Center Buy-Sell Offset Pips 0
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TIME AND DAY INPUTS

  Grid Start Time ignore
  Grid Stop Time ignore
  Trade Monday true
  Trade Tuesday true
  Trade Wednesday true
  Trade Thursday true
  Trade Friday true
  Trade Sunday true
  Close For Sunday-Friday Time ignore
  Friday Close Time ignore
  Friday Close Profit Only true
  Friday Close Time Period 120

MISCELLANEOUS INPUTS

  Show Comments true
  Log Activity true
  Log Debug Info false

CLOSE-RUN OPTIONS

  CR Auto Restart ( Always; Profit-Only; Loss-Only; Never )
  CR Include Closed Trades Net true
  CR Total Profit Percent 0.0
  CR Total Loss Percent 70.0
  CR Trail-Stop Percent (TSP) 0.0001
  CR Profit Percent Before TSP 0.3
  CR Loss Money 0.0
  CR Trail-Stop Money (TSM) 0.0
  CR Profit Money Before TSM 0.0
  CR Profit Pips 0
  CR Loss Pips 0
  CR Trail-Stop Pips 0
  CR Price Maximum 0.0
  CR Price Minimum 0.0

IMMEDIATE-CLOSE OPTIONS

  Close Greater-Profit-Than 0
  Close Greater-Loss-Than 0
  Close Orders-Type ( Buys-and-Sells; Buys-Only; Sells-Only )
  Close Orders Now ( Close-None; Delete-Pending; Close-Trades;

      Close-At-Specified-Profit-Loss; Close-Run-Now )

Important - Some of the above settings can be changed on-the-fly.  This means that if the EA properties-panel is
opened while ForexGM is active, specific input settings can be modified without the need to remove the EA and
reapply it to a chart.  Settings that can be changed on-the-fly are generally those that will not change the basic
trading strategy. 

Important - There are more options in the  ForexGM_Express.prf  file to control various aspects of ForexGM – the
information displayed on the chart; setting of Alerts; Aesthetics and more.  A separate instance of this file is located in the
Tester/File folder that applies to Strategy Tester runs.  Note that the settings in this file apply to all instances of ForexGM
that are installed on the various charts in the MT4 terminal. 

Important - Be sure to back-test and walk-forward-test your strategies extensively in Strategy Tester for a year or more
to fully appreciate the functionality of the settings and their combined effects.  Trade with a demo-account before you
trade a real money account.  Please do not underestimate how important these steps really are.  Be the master of your
destiny.  “Risk comes from not knowing what you are doing.” -- Warren Buffet.
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ForexGridMaster Input Settings Detail
The values of settings listed below are those built in as the default for ForexGM Express at the time of writing.

This Buy-Sell Counter-Trend strategy was tuned at some stage to be suitable for trading the AUDNZD pair.  With a
slight adjustment to the settings, it may work for other currency-pairs that have similar price action.  In any case, the
default strategy is for demonstration purposes only.  Back-test and walk-forward test all ForexGM strategies over at
least a 3 year historical period to gain a thorough understanding of how the strategy works and what the risks are
before trading real money.

A few videos have been uploaded to the  ForexGridMaster YouTube Channel to illustrate ForexGM in action.
There is a demonstration of a back-test for a previous strategy that ran live YTD until August 30, 2014, with an
explanation of  the methodology as it  trades.   Also included is  a video which goes into detail  about the Spike
Protection mechanism.  Some of these videos may refer to previous versions of ForexGM, but we plan to provide
updates in the near future.

We strongly recommend following the processes illustrated in the videos – it should help when customizing the
strategies for a particular trading style,  risk-tolerance, and goals.   Portfolio trading can be set up by trading a
second instance (or more) of ForexGM on a second chart (or more) and dividing Account deposit into sub-accounts
using the Chart Equity Percent setting.

EA Number:
This input enables each instance of ForexGridMaster Express (ForexGM) to independently keep track of its own

trades and calculations without influence from other instances of ForexGM, other EAs, or any manual trades.  The
EA Number should be unique for every EA instance running on the terminal, and because only one EA can be
attached to a chart, the EA Number also uniquely identifies a chart.  ForexGM’s input settings affect only orders
associated with the EA Number of the particular ForexGM instance.  The EA Number can have any numeric value
up to a maximum of 9 digits, as long as there is no conflict with other EAs.

ForexGM has several mechanisms to help prevent duplicate EA numbers – before accepting any modification to
the settings, a check is made to see if there are other ForexGM instances already running with the chosen number.
Any attempt to change an  EA Number assigned to chart by a previous run of ForexGM will  be rejected, thus
helping to prevent unintentional loading of unrelated set-files.  Global Variables are used to store persistent data
related to each ForexGM instance, and it is recommended that ForexGM EAs and possibly their related charts are
removed when no longer required.  This setting cannot be changed on-the-fly.

Strategy File [ STF ]:
This field can contain any text up to a maximum of 64 characters.  Text entered here will be displayed in the top

line of the comments at the top right of a chart.  You can type anything here, but a meaningful description can help
when screen-shots are archived for future study.  Text might relate to the set-file name and also contain some
reference to the parameters driving the strategy.  This setting can be changed on-the-fly.

Strategy Info [ STI ]:
As with the Strategy File setting above, any text can be entered, and it will be displayed on the second line of

the chart comments.  It might be useful to include additional details describing the particular strategy.  This setting
can be changed on-the-fly.

Chart Equity Percent [ CEP ]:
ForexGM instances can trade with a specific Chart Equity, which can be any amount from 0 to 100% of Account

Equity.  At the start of each run, Chart Equity is calculated from the current Account Equity and the CEP value.
When set to the default 100%, all funds in the trading account are available to ForexGM for trading.  Please note
that this differs from the way Chart Equity was handled in previous versions where Chart Equity was set to a
specific monetary value.  CEP provides a simple mechanism to control money-management.  Because Chart Equity
is only determined at the start of a run, it can be changed on-the-fly to take effect when the next run commences.
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Grid Type:  ( Fixed-Center-Grid;  Moving-Center-Grid )
 When trading a  Fixed-Center-Grid strategy, the center-line for the grid will  be the current market Bid price

when ForexGM starts each Run.  However if Open At Current Price is enabled for either a Buy or a Sell, then the
center-line will  be half the  Grid Spacing pips value away from the price that the Buy or Sell trade opened, and
exactly between the first Buy or Sell slots of the Grid.  For Fixed-Center-Grid, the grid center-line will remain at the
same price for the duration of the Run and the rest of the grid will be based on that price.  There are six settings
specifically related to Fixed grids – Fixed-Center Inputs  The Grid Type cannot be changed on-the-fly.

Trading a  Fixed-Center-Grid strategy, the Buy and Sell pending orders are kept separated from each other,
Buys on one side of center-line price and Sells on the other, with no overlap allowed.  As an example, when
ForexGM Express trades a Buy-Sell Trend strategy, only pending Buy Stop orders can be placed above the center-
line price and only pending Sell Stop orders can be placed below.  If ForexGM was trading a Buy Trend Half-Grid,
then only pending Buy Stop orders would be placed above the grid center-line.  For a Buy Counter-Trend Half-Grid
strategy, only pending Buy Limit orders are placed below the center-line.

A Moving-Center-Grid will change to always be the current moving market Bid price when you trade either a
Buy or a Sell grid, or a Buy-Sell grid combined with Buy-Sell Overlap = true and Buy-Sell Offset = true.  However,
when trading a Buy-Sell grid with  Buy-Sell Overlap = false, the  Moving-Center option will place the center-line
between the Buy and Sell orders, and will continue moving to maintain that relative position.  Buy and Sell pending
orders will be placed as close as possible to the moving center-line price according to the Grid-Spacing and the
Center-Zone  Pips settings.   See  the  section  illustrating  how  this  works  --  FixedCenter  and  MovingCenter
Scenarios.

Some brokers do not allow pending orders to be placed within 5 - 20 pips (more or less) of market price, and so,
depending on the Grid-Spacing, the initial grid position slots adjacent to grid center may not be filled with pending
orders until the current price has moved away far enough to allow it.  In the meantime, grid slots further away from
the grid center-line are filled where possible according to the already established initial center-line price and other
input parameters.
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GRID GENERAL INPUTS

Order Type [ OT ]:  ( Buy-Sell; Buy-Full; Sell-Full; Buy-Half; Sell-Half  )
This input determines whether the trade orders placed by ForexGM Express are either All Buy orders, All Sell

orders, or Both Buy and Sell orders, and also whether they are Half-Grid or Full-Grid.  As an example, if the default
Buy-Sell is selected to trade a Trend grid to capture profit in the direction of the price trend, then Buy Stop orders
will be placed above grid center and Sell Stop orders below.  If Buy-Sell is chosen with the Counter-Trend option,
then Buy Limit orders will be placed below grid center and Sell Limit orders above. This setting cannot be changed
on-the-fly.

Orders will be placed symmetrically on both sides of grid center when set to Buy-Full or Sell-Full, or one side
only when set to Buy-Half or Sell-Half.  Buy-Sell grids automatically trade two half-grids, with one half Buy orders
and the other half Sell orders.  This setting cannot be changed on-the-fly.

Here are some basic examples … 

You might wish to trade a Buy Trend grid to profit on price that is trending upwards.  Choosing full-grid will
place pending Buy Stop orders above the center-line price and pending Buy Limit orders below for either a
Moving-Center-Grid or  Fixed-Center-Grid strategy.   For  a half-grid,  pending Buy Stop orders will  be
placed above the center-line price, but no Buy Limits below.  Using half-grids when trend-trading in only one
direction will reduce the number of open negative trades that accumulate over long price runs or spikes in
the opposite direction of the trend.  Depending on the Grid-Spacing and the strength of the market trend,
you might be able to reduce the number of losing trades caused by retracements which open Buy Stops
that follow the price downwards.
If the price is expected to initially drop and then turn up shortly afterwards, an appropriate strategy would
use a Buy, Counter-Trend, Half-Grid.  This would place a half-grid of pending Buy Limit orders below the
center-line, but no Buy Stops above.
For a price that stays within a relatively well defined range, a strategy set for Buy-Sell and Counter-Trend
should work well.  The Buy-Sell strategy trades two half-grids, placing pending Sell Limit orders above the
center-line, and pending Buy Limit orders below.

Trend Direction [ TD ]:  ( Trend; Counter-Trend )
This input determines whether the grid is for a  Trend or a  Counter-Trend strategy.  If  Order Type is set to

either Buy-Full or Sell-Full, the option is ignored.  A Trend grid places Buy Stops above grid center (Buy Trend), or
Sell Stops below grid center (Sell Trend) or both (Buy-Sell Trend).  A Counter-Trend strategy places Buy Limits
below grid center (Buy Counter-Trend), or Sell  Limits above grid center (Sell  Counter-Trend) or both (Buy-Sell
Counter-Trend).  If  Center-Zone Pips is set non-zero, the top and bottom levels of the center-zone will be used
instead of the grid center.  This setting cannot be changed on-the-fly.

Grid Spacing [ GS ]:
This input sets the distance in pips between each pending order grid-slot and the next grid-slot for orders of the

same type (Buys or Sells).  If the  Center-Zone Pips  setting is used, the first pending orders are placed at the edge
of the zone, and Grid-Spacing applies from there.  This setting cannot be changed on-the-fly.

Max Pending Buy Orders [ MPBO ]:
This input determines both the number of pending Buy Limit or Buy Stop orders that the strategy will place at

grid start, and the maximum number of pending Buy orders permitted at any one time.  If either or both Max Open
Buy Trades and  Max Open Sell Trades are set to be greater than the default 1, then their values are used to
determine the limit of open trade slots allowed, and the number of pending orders will be controlled accordingly.
This means you cannot set MMPBO to a higher value than set for Max Open Buy Trades.  If the number of open
Buy or Sell trades reaches the limit but then decreases (one or more open trades are closed), then ForexGM will
resume opening pending orders as dictated by the other strategy settings.  ForexGM also limits the total number of
open pending orders to a maximum of 100.  However, be aware that some brokers may not allow that many open
trades.  This setting can be changed on-the-fly to a higher value but not lower.

Max Pending Sell Orders [ MPSO ]:
This operates exactly like Max Pending Buy Orders above, but applies to pending Sell orders.
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Max Open Buy Trades [ MOBT ]:
When set to the default 0, then no Buy trades can be opened.  Any other numeric value sets a  limit on the

maximum number of open Buy trades that ForexGM allows at any one time.  Manual trades or other EAs with their
own unique EA Number can operate on the same account without influence from this setting.  Many brokers limit
the total number of open orders in an account, but some do not -- check with your broker if you plan on heavy
trading.   This setting can only  be changed on-the-fly when Main-Grid  is  set  for  Moving-Center-Grid.   In this
situation, for example with Max Open Buy Trades = 20, the total number of grid Buy slots (positions) that can be
occupied by Buy orders on the Buy side of the grid is fixed at 20.  Trade orders occupying any of those 20 positions
can be opened, closed and replaced within a Run according to values set for other ForexGM inputs.

Max Open Sell Trades [ MOST ]:
This operates exactly the same as Max Open Buy Trades above, but applies to Sell orders.

Center-Zone Pips [ CZP ]:
When set to the default 0, this input is ignored.  For a Moving-Center-Grid or Fixed-Center-Grid with Center-

Zone Pips set to a number greater than 0, the Buy and Sell orders will  be separated by at least the specified
number of pips.  For example, if Center-Zone Pips = 30, then no grid orders (pending or open) can occupy a slot
inside that 30 pip zone.  If a  Moving-Center-Grid strategy is deployed, then the center-zone can move as the
position of the Buys and Sells move.  However, no grid orders (open or pending) can occupy a position within the
CZP.  When trading a Half-Grid, say a Buy Trend strategy, then the exclusion zone extends to half the CZP value
from the grid center-line.  This setting cannot be changed on-the-fly.

      When trading a  Moving-Center-Grid strategy, CZP moves in the direction of price and closing orders --  if
orders are closed within the current Run, the center-zone will be adjusted to maintain the separation between the
Buy and Sell orders.  For a Moving-Center-Grid on a Buy-Sell strategy with Buy-Sell Overlap set to true, CZP must
be disabled to allow overlaps to occur.   However,  when trading a  Fixed-Center strategy,  the center-zone will
remain fixed in place for the duration of the Run, keeping Buys and Sells separated by the value set.  There are a
few examples of  Center-Zone Pips for both  Fixed-Center-Grid and  Moving-Center-Grid in  a later  section –
FixedCenter and MovingCenter Scenarios.

Grid Order Replacement [ GOR ]:
If set to true, when a Grid order has closed it will be replaced if the price returns to that same grid slot within the

same Run.  If false, then each order within a Run will only be activated once for any given grid position.  This setting
can be changed on-the-fly.

Open At Current Price [ OCP ]:  ( Not-Used; Buy-Order; Sell-Order )
When set to  Not-Used, this setting is ignored.  Set to either  Buy-Order or  Sell-Order, an order is opened

immediately at current price at the start of each Run.  All other pending grid orders placed during the Run are
adjusted to that price position.  In other words, the immediately opened trade is part of the grid being traded, and
therefore determines where the Grid-Spacing is anchored.  For example, if Center-Zone Pips = 20 and a Buy is
opened at 1.3000 for a  Buy-Sell Trend strategy, then the center-zone is from 1.3000 to 1.2980 and the grid is
structured around that price, the first pending Sell order slot being set at 1.2980. 
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GRID ORDER INPUTS

These settings apply to all individual orders for both Fixed-Center-Grid and Moving-Center-Grid scenarios in the
main grid.  Some extra settings which apply specifically to Fixed-Center-Grid or Moving-Center-Grid are covered
in following sections.

Lot-Size [ LS ]:
This input sets the base lot-size for individual Buy and Sell orders placed within a particular Run.  Most brokers

allow a minimum lot-size of 0.01 which is 1/100th of the standard $100,000 lot-size, or $1,000 (using USD as
example) and for ForexGM, 0.01,  a micro lot,  is the minimum lot-size that can be set.   Some brokers require
minimum lot-sizes 10 times higher to 0.10 ($10,000, a mini lot) in which case ForexGM will display a message that
the value needs to be within broker limits before trading can continue.  Brokers sometimes provide Mini Accounts
with minimum lot-size of 0.01 which is 1/100th of the Mini Account lot-size of $10,000, or $100 in trade, a Nano lot.
Brokers sometimes offer the option to trade Micro-Accounts with a minimum lot-size of 0.01 which is 1/100th of the
Micro Account lot size of $1,000, or $10 in trade, a pico lot.

  For  Fixed-Center-Grid, the actual lot-size for individual orders within a Run can be controlled by  Lot-Size
Increase Amount,  Lot-Size Increase Percent, or  Lot-Size Increase Fibonacci.  This setting cannot be changed
on-the-fly for Fixed-Center grids.  However, it can be changed for Moving-Center-Grid, but it will only affect new
pending orders and not pending orders already placed.

Lot-Size Scaling [ LSS ]:  ( LotSize-Constant; LotSize-Proportional )
The base lot-size for trade orders can remain constant for all Runs, or can change from Run to Run depending

on the Lot-Size Scaling setting, either LotSize-Constant or LotSize-Proportional.  Lot-Size Scaling cannot be
changed on-the-fly.

If  LotSize-Constant is selected, the base lot-size at the beginning of each Run is reset to  Lot-Size  [MLS].
When set to the default LotSize-Proportional, lot-size is set to MLS for the very first Run.  On all subsequent Runs,
the base lot-size is set at the start of each Run to be MLS increased or decreased by the ratio of Current-Chart-
Equity to Original-Chart-Equity.  However, if the calculated value is less than the MLS value set above, the lot-size
will be set to MLS for each new pending order placed until the new calculations result in a lot-size larger than MLS.
An exception to this rule could occur for Main_Grid Fixed_Center where lot-sizes are predefined for the slots and
there might be a dip in equity causing a new lot-size calculation lower than MLS.  The absolute minimum value for
lot-size for any order is set by the broker, and ForexGM will apply this restriction if necessary.

LotSize Proportional can allow profits to compound when the equity curve is following an upward trend.  On the
other hand, it can also reduce losses for a less-positive equity trend.  As an example, suppose account-equity starts
Run 1 at $10,000 with Lot-Size = 0.10;  LotSize-Proportional;  CR_ProfitPercent = 10; and CR_LossPercent =
30.  If the Close-Run is positive and reaches its equity increase profit target of 10% net of all open and closed
trades within the Run (CR Include Closed Trades Net = true), then start equity for Run 2 will be $11,000, and Lot-
Size will automatically be increased to 0.11.  If the Close-Run was negative and the equity reduced 30% to $7,000,
the Lot-Size for Run 2 would be decreased to 0.07.

Take-Profit Pips [ TPP ]:
This input determines how many pips profit each of the individual trade orders will target.  For example, you

might be trading the EURUSD, and a pending Buy order is open at 1.3700 with Take-Profit Pips = 35.  If the price
reaches 1.3735, the trade will be closed by the broker capturing 35 pips profit (ignoring slippage).  When set to 0,
this input is ignored.  For  Moving-Center-Grid only, this setting can be changed on-the-fly, although  it will only
affect new pending orders and not pending orders already in place.

Stop-Loss Pips [ SLP ]:
This determines the Stop Loss for each individual trade order.  If set to the default 0, this input will be ignored.  If

for example you are trading the EURUSD and a trade order opens at 1.3700 with Stop-Loss Pips = 50, and if the
price then drops to 1.3650, the trade will be triggered to close at a loss of 50 pips.  This setting can be changed on-
the-fly when trading a Moving-Center-Grid, and will affect new pending orders only, not pending orders already in
place.

Break-Even Stop [ BES ]:
When set to true, a break-even Stop-Loss will  be set for each order according to the rules dictated by the

additional settings Profit Pips Before Break-Even Stop and Break-Even Stop Plus Pips.  Set to false, BES is
disabled and the associated settings are ignored.  These settings can work in conjunction with Profit Pips Before
Trail-Stop Pips described below.  These settings cannot be changed on-the-fly.
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Profit Pips Before Break-Even Stop [ PPBBE ]:
When BES = true, this setting is enabled.  If set to 10 as an example for an open pending order, and the price

moves 10 pips into profit, a break-even stop is placed on the order so that a price retrace will close the order at
break-even plus the value of  the following BESPP parameter.   This value can only be set  to whole pips,  not
fractional pips. 

Break-Even Stop Plus Pips [ BESPP ]:
The value in pips set here adds to the break-even stop.  For example, if BESPP is set to 3 pips and PPBBE = 10

pips, it means that when an open order reaches its 10 pip profit target and BES is triggered, a price retrace of 7 pips
(10 – 3) will cause the order to close 3 pips in profit.  This setting is useful to offset commission, swap fees or
slippage.

Trail-Stop Pips [ TSP ]:
This input determines the number of pips the trail-stop should be placed away from the open price.  As an

example, if TSP = 50 and PPBTS = 0, then a stop-loss is immediately set at 50 pips away from the pending order
open price.  That stop-loss will then trail pip by pip as the price moves in a profitable direction.  If price moves in a
losing direction then the trailing stop-loss will  remain stationary and close the order when the stop-loss price is
reached.  Another example -- if TSP = 9 and PPBTS = 36, when each individual order is 36 pips into profit, the trail-
stop of 9 is triggered and 27 pips of profit will be locked in.  If the price keeps moving in a profitable direction, the
trail-stop will follow pip by pip.  Let’s say that an individual order moves 50 pips into profit and then retraces 9 pips.
The trade would then close out with 41 pips profit.

Profit Pips Before Trail-Stop Pips [ PPBTS ]:
If  set to the default  0 pips, this setting is ignored.  Set to a value such as 36 as an example, each of the

individual orders that are opened will need to move 36 pips into profit before Trail-Stop Pips is activated.  If PPBTS
= 0 then TSP will determine the initial trailing stop-loss.  This functions differently to Stop-Loss Pips which fixes the
Stop-Loss on the broker's server.  This setting cannot be changed on-the-fly.

Max Order-Period [ MOP ]:
The value of this setting specifies a period of time in seconds that works in conjunction with the next setting,

Max Order-Frequency.  If set to the default 0, then this setting and the next setting are ignored.  If set to 900
seconds (15 minutes) for example, then Max Order-Frequency specifies the maximum number of trade orders that
can be placed within Max Order-Period.

 Max Order-Frequency [ MOF ]:
If  Max Order-Period is greater than 0 seconds, then this setting is activated.  If set to a value such as 2 for

example, it means that no more than 2 trade orders can be opened within the time period specified by the previous
Max Order-Period setting.  These settings are used to counteract  large price spikes and swings by reducing the
number of negative accumulating trades.  Please note however that those 2 trades will probably be in loss, and any
other open trades that are in profit during the Max Order-Period will be ignored because price is moving against
the 2 trades set by Max Order-Frequency.  The open trades in profit are moving towards their Take-Profit target
and will be closed at the appropriate time.  This setting and the related Max Order-Period can be changed on-the-
fly.
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GRID FIXED-CENTER INPUTS

The following parameters modify grid orders for Fixed-Center-Grid, and are ignored for a Moving-Center-Grid.
All these settings depend upon the slot position where an order is initially placed.   If  Grid Order Replacement is
true, then any order replacing one that was closed earlier in the Run will have exactly the same characteristics as
the order it replaces.

Grid-Spacing Step [ GSS ]:
When set  to the default  0,  this  input  is ignored.   Set  to a non-zero value,  the space between grid-slots  is

increased incrementally by that amount as the grid moves out from its center-line.  The value can be either a whole
number or a decimal representing fractional pips.  For example, if trading a Buy-Sell grid with Grid-Spacing = 10
and Grid-Spacing Step = 0.2, the separation between the first Buy and first Sell slot positions will be 10 pips. The
interval between the first and second Buy slots will be 10.2 pips, then 10.4 pips for the next, and so on.  Same
formula applies to the Sell orders in the other half of the grid.  Whenever a new Run commences, Grid-Spacing
Step starts to increment the spacing again from scratch.  This setting cannot be changed on-the-fly.

Grid-Increment Percent [ GIP ]:
MGIP works in a similar way to the MGSS setting above.  The default of 0 means this setting is ignored.  As an

example, suppose Grid-Spacing is set to 10 with GIP = 10% for a Buy-Sell grid.  Separation between center-most
slots will be 10 pips.  Next slots will be spaced 11 pips apart, then 12.1,  and so on.  This setting should not  be
changed on-the-fly.

Lot-Size Increase Amount [ LIA ]:
Default for this setting is 0, which means the input is ignored.  When non-zero and Main-Grid = Fixed-Center,

the base lot-size as determined by either  LotSize-Constant or  LotSize-Proportional, is increased incrementally
from one pending order slot to the next by that amount.  For example, if the base lot-size for a grid is 0.15 and LIA =
0.01, then lot-size for the next pending order placed at slot #2 will be 0.16, the next one 0.17, next 0.18, and so on.
When a Run is closed (all open trades closed and pending orders deleted) and a new Run begins, the lot-sizes are
allocated as previously either by Lot-Size or Lot-Size Percent.  This setting cannot be changed on-the-fly. 

Lot-Size Increase Percent [ LIP ]:
When set to the default 0, this input is ignored. When set to a percent for a Fixed-Center-Grid, the lot-size as

determined by either  LotSize-Constant or  LotSize-Proportional,  is increased incrementally by that percentage
from one pending order slot to the next.  This setting may be useful for Martingale strategies made famous by
professional gamblers.  For example, if the starting pending order lot-size is say 1.20 and LIP = 100%, then the next
pending order lot-size would be increased by 100% to 2.40, the next to 4.80, then 9.60, and so on.  For a starting
lot-size of 1.20 and MLIP = 50%, the next pending order lot-size would be increased by 50% to 1.80, followed by
2.70, 4.05, etc.  As a new Run begins for a Fixed-Center-Grid, lot-sizes are again calculated using the formula
described above.  This setting cannot be changed on-the-fly.

Lot-Size Increase Fibonacci [ LIF ]:
Default is false and this input is ignored.  When set to a true for a Fixed-Center-Grid, the lot-size set by either

LotSize-Constant or LotSize-Proportional, is increased incrementally from one pending order slot to the next in
accordance with the Fibonacci series... 0, 1, 1, 2, 3, 5, 8, 13, 21, 34, 55, 89, etc.  The series is based on the formula
“next number = current number + previous number”.  For example, if the base lot-size is 1.2, then the next lot-size
will be 1.2 (1.2 + 0, the previous lot-size); next lot-size will be 2.4 (1.2 + 1.2), next 3.6 (2.4 + 1.2), then 6.0 (3.6 +
2.4), 9.6, and so on.  When a fresh Run starts, these lot-sizes are again calculated using the formula with whatever
base lot-size applies at the time.  This setting cannot be changed on-the-fly.

Take-Profit Pips Step [ TPPS ]:
When set to the default 0, this input is ignored.  For a non-zero value, Take-Profit Pips is incremented by TPPS

from one pending order slot to the next.  For example, if TPP = 20, TPPS = 0.5 and there are 6 Fixed-Center-Grid
slot Buy positions (created with Max Open Buy Trades = 6), then the order at Buy slot 1 (closest to grid center) has
Take-Profit Stop = 20; the Buy order at slot 2 position has Take-Profit Stop = 20.5; Buy 3 to Take-Profit Stop = 21;
Buy 4 Take-Profit Stop = 21.5; Buy 5 Take-Profit Stop = 22; and Buy 6 (furthest from grid center) has Take-Profit
Stop = 22.5.  Not only can the lot-size be increased for grid orders moving out from grid center, but their Take-Profit
pips can increase as well – this might prove useful for Counter-Trend strategies stretched over a large range where
larger retracements are required.  This setting cannot be changed on-the-fly.
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GRID MOVING-CENTER INPUTS

The following two settings apply to Moving-Center strategies.  They are ignored for Fixed-Center grids. 

Moving-Center Buy-Sell Overlap [ MCBSOV ]:
When set  to true, grid Buy orders and Sell  orders can overlap.   Moving-Center Buy-Sell  Overlap = false

ensures all pending or open Buy orders on one side of the grid will remain separated from all Sell orders on the
other side (see examples below).  This setting cannot be changed on-the-fly.

Moving-Center Buy-Sell Offset Pips [ MCSOP ]:
This option prevents Buy and Sell orders from occupying the same price slot positions when trading a Buy-Sell

strategy involving  Moving-Center Buy-Sell Overlap set to true.  If Buy and Sell orders are placed at the same
price, it can be difficult to identify them by their graphical representation on a chart.  A slight offset can make them
more distinguishable without greatly affecting trading outcomes.  MCSOP specifies how many pips Sell orders will
be placed below Buy orders in a Buy-Sell grid where Buys and Sells overlap.  This does not affect Grid-Spacing or
Center-Zone Pips for either type of grid.   This setting cannot be changed on-the-fly.

  Here are a few examples using EURUSD prices...

Grid-Spacing = 6
Center-Zone Pips = 0
Buy-Sell Overlap = true
Buy-Sell Offset Pips = 3

------------- 1.37070
--- Buy --- 1.37060
------------- 1.37050
------------- 1.37040
--- Sell --- 1.37030
------------- 1.37020
------------- 1.37010
--- Buy --- 1.37000
------------- 1.36990
------------- 1.36980
--- Sell --- 1.36970
------------- 1.36960
------------- 1.36950
--- Buy --- 1.36940
------------- 1.36930

Grid-Spacing = 6
Center-Zone Pips = 0
Buy-Sell Overlap = true
Buy-Sell Offset Pips = 1

------------- 1.37070
--- Buy --- 1.37060
--- Sell --- 1.37050
------------- 1.37040
------------- 1.37030
------------- 1.37020
------------- 1.37010
--- Buy --- 1.37000
--- Sell --- 1.36990
------------- 1.36980
------------- 1.36970
------------- 1.36960
------------- 1.36950
--- Buy --- 1.36940
--- Sell --- 1.36930

Grid-Spacing = 3
Center-Zone Pips = 6
Buy-Sell Overlap = false
Buy-Sell Offset Pips = 0

------------- 1.37070
--- Buy --- 1.37060
------------- 1.37050
------------- 1.37040
--- Buy --- 1.37030
---- CZ---- 1.37020
---- CZ---- 1.37010
---- CZ---- 1.37000
---- CZ---- 1.36990
---- CZ---- 1.36980
--- Sell --- 1.36970
------------- 1.36960
------------- 1.36950
--- Sell --- 1.36940
------------- 1.36930
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TIME  AND DAY INPUTS

Grid Start Time:  ( default = “ignore” )
When set to the default “ignore”, this setting has no effect.  This input determines the time of day when ForexGM

will open a grid of pending orders.  It is the 24-hour time relative to Market Watch time which is displayed on the
title-bar of the Market Watch panel of the terminal when connected with a broker and the market is open.  If Grid
Start Time = 00:01 as one example, then ForexGM is activated at 00:01 (midnight) Market Watch time.  If set to
08:30, then ForexGM will start placing orders automatically at 8:30 am.  If set to 20:30, then orders will be placed
from 8:30 pm onwards.  Grid Start Time can work independently, or in conjunction with Grid Stop Time.  If Grid
Start Time is set to any value and Grid Stop Time = “ignore”, all orders will be closed at midnight on the day they
opened, ready to start again the next day if required.  This setting can be changed on-the-fly anytime before it has
been triggered.

Grid Stop Time:  ( default = “ignore” )
When set to the default of “ignore”, this setting is ignored as one might expect.  This input determines what time

ForexGM will stop the present Run and close out all open trades and delete all pending orders.  The format is the
same as for  Grid Start Time, and these two settings work in tandem to control the daily period for trading.  For
example, if  Grid Start Time is set to 23:00 and Grid Stop Time is set to 07:25, then ForexGridMaster will trade
through the night and shut down at 07:25 (7:25 am) in the morning to start a new Run at 23:00 (11:00 pm).  This
cycle is repeated for  all trading days that are enabled (all days are enabled by default).  Another scenario might
have the time period set by  Grid Start Time /  Grid Stop Time as 08:05 to 19:35, which would result in active
trading from 8:05 am through the day until 7:35 pm.  This setting can be changed on-the-fly anytime before it has
been triggered.

Trade Monday:  ( default = true )
Trade Tuesday:  ( default = true )
Trade Wednesday:  ( default = true )
Trade Thursday:  ( default = true )
Trade Friday:  ( default = true )

When one or more of the Trade Day input settings are set to their default values of true, trading is enabled for
those particular days, week after week, continuously until these settings are changed.  Trade Day settings are
based on Market Watch time which is displayed on the title-bar of the Market Watch window on the MetaTrader 4
terminal.  The time period for each  Trade Day starts at 00:00:00 Midnight and ends 24 hours later at 23:59:59.
Whenever one or more of the Trade Day settings are set to false, then trading is disabled for those days, and a
complete Close-Run is triggered at 00:00:00 on the specified days to close all open trades and delete all pending
orders.  If CR Auto-Restart = true, a new Run will start automatically, but not until the next enabled Trade Day.  If
CR Auto-Restart = false, the EA must be manually restarted.  These Trade Day settings can be changed on-the-fly
anytime before their trigger time.

As an example, if Trade Monday is set to false, trading will be disabled for Mondays from 00:00:00 to 23:59:59
Market Watch time.  If a Run is open and trading on the preceding Sunday, then that Run will close at 00:00:00
midnight Market Watch time between Sunday and Monday, and a new Run will not start up automatically until the
next enabled Trade Day.  When Close-Run is triggered, all open trades and pending orders are closed.

Trade Sunday:  ( default = true )
Sundays are handled differently from the other days because the market can sometimes be closed to reopen on

a Sunday.  This is the case for most Forex instruments that cease trading over a weekend.  So, if Trade Sunday =
false and Trade Friday = true, then any Run in progress on Friday actually needs the Close-Run function triggered
at least 15 minutes before market closing-time on Friday (see Close For Sunday-Friday Time).  This will ensure all
open trades and pending orders are closed before the Friday market close.  The  Trade Sunday setting can be
changed on-the-fly anytime before its trigger time.

Close For Sunday-Friday Time:  ( default = “ignore” )
This setting is activated when Trade Sunday = false.  It is important to check the Market-Watch times that the

market is open for your particular broker.  Forex trading is normally closed on Fridays by the broker, and any time
set here should be at least 15 minutes before the Friday market close to allow sufficient time for all trade orders to
close.  For example, one account we have with GoMarkets in Australia closes on Friday afternoons at the Market-
Watch time of 22:59:59, so in this case we use the setting Close For Sunday Friday Time = 22:30.  This setting is
useful to close out orders on Friday afternoon to avoid the weekend gap that shows up at the Sunday evening
market-open.  This setting can be changed on-the-fly anytime prior to its trigger time.
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Friday Close Time:  ( default = “ignore” )
When set to “ignore”, this setting and the next two, Friday Close Profit Only and Friday Close Time Period,

will be ignored, no matter what values they are set to.  When set to a close time according to the MetaTrader 4
Market-Watch time, 08:25, 11:45, or 14:00 as examples, and in the same 24-hour clock 'hh:mm' format, the current
Run will be closed at the specified Friday Close Time unless cancelled or modified by the following two settings.

If the current Run is closed by Friday Close Time and the setting CR Auto-Restart = true, the restart will be
ignored and ForexGM will  be stopped and can only be started again manually.   This setting is useful to avoid
possible large unexpected price gaps that can occur over the weekend, or simply just to close ForexGM at the end
of the trading week.  Depending on activation of the next two settings, Friday Close Profit Only and Friday Close
Time Period, this setting can continue to operate from week to week until it triggers a Close-Run.  This setting can
be changed on-the-fly any time before its trigger time. 

Friday Close Profit Only:
If set to true, the Run will close at the Friday Close Time set, but ONLY if the current Run net profit of all trades,

both open and closed, is positive either at that exact time, or within the period specified by Friday Close Time
Period.  If set to false, then this setting is ignored and the current Run will be closed immediately at the set Friday
Close Time.   This setting can continue to operate from week to week until  it  triggers a Close-Run.  It can be
changed on-the-fly any time before its trigger time. 

Friday Close Time Period:
This setting works in combination with Friday Close Time and Friday Close Profit Only.  If set to zero then this

setting is ignored.  If set to 120 minutes for example, it means that during the 120 minute  Friday Close Time
Period commencing from the Friday Close Time, ForexGM will monitor the current Run net profit, and will close
the Run if and when it reaches  profit within that 120 minute window.  Otherwise, the Run will not be closed.  Using
Friday Close Time = 14:00 as an example, at 14:00 ForexGM examines the current situation and will immediately
activate a Close-Run if the Run is in profit.  If the Run does not go into profit during the set  Friday Close Time
Period of minutes, then the Run will continue trading when the market next opens.  This setting can continue to
operate from week to week until it triggers a Close-Run. It can be changed on-the-fly any time before its trigger
time.

MISCELLANEOUS INPUTS

The settings in this section apply to the overall strategy.

Show Comments:  ( default = true )
ForexGridMaster  displays  very useful  information in  comments at  the top right  corner  of  a chart,  including

Strategy File-Name and Info, Current Run Statistics, Max Equity Drawdown, etc.  If Show Comments is set “false”,
then  no  comments  are  displayed.   The  display  of  comments  is  also  controlled  by  a  parameter  in  the
ForexGM_Express.prf file.  If Show Comments is set to “true” or “false”, it will take precedence over any option set
in the Profile.

Log Activity:  ( default = true )
The  default  is  set  “true”  to  allow  extra  information  to  be  saved  to  the  system  log-file  in  the  [MT4  Data

Folder]\MQL4\Logs  directory.   These  details  can  help  troubleshoot  problems  when  ForexGridMaster does  not
appear to be functioning correctly.  When there is a problem, log-file entries can be viewed in the “Experts” tab at
the bottom of the Terminal window.  Right click on an entry and choose “Open” to view the whole log-file for that
day or any previous days.

Log Debug Info:  ( default = false )
Like the setting above, this input can be set to “true” to record even more detail in the system log-file saved at

the [MT4 Data Folder]\MQL4\Logs.  See Testing and Problem Solving below for more information.
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CLOSE-RUN OPTIONS

The net Profit/Loss for orders within a Run will trigger a Close-Run when conditions meeting any of the following
criteria are met.  The Net Profit is displayed in the ForexGM comments on a chart.  A grid Run will be stopped on
the next tick after a Close-Run is triggered, and all orders controlled by the specific ForexGM instance will close.
The following parameters specify  conditions for  Close-Runs that are  not  visible  to  the broker,  and hence are
referred to as Stealth-Mode settings.

CR Auto Restart:  ( Always; Profit-Only; Loss-Only; Never )
If set to the default Always, then ForexGM will automatically restart a new grid Run immediately after a close of

the current Run is triggered by any of the settings in this section.  If set to either Profit-Only or Loss-Only, then a
new Run will be started accordingly, after a CloseRun has completed.   When a Run is closed without Auto Restart,
ForexGM must be manually reset to start trading again for a new Run.  This setting can be changed on-the-fly. 

CR Include Closed Trades Net:
Most of the following options depend on a Profit/Loss calculation involving trades made during a particular Run.

This parameter dictates whether or not to include trades that have been closed within the Run.  When set to the
default true, the net Profit/Loss calculation includes all related grid-trades that have been closed within a Run.  In
other words, when CR Include Closed Trades Net is set false, the calculation of net Profit/Loss involves only open
trades, and not any trades that have been closed within the Run.

CR Total Profit Percent:
If set to the default 0, this input is ignored.  Otherwise, it specifies the percentage of equity-profit that will trigger

a Close-Run which closes all open trades and deletes all pending orders.  ForexGM Express will then automatically
initiate the next Run provided Auto Restart After Profit is enabled.  For example, if CR Total Profit Percent = 3, it
means that 3% of the Start Equity for the particular Run is the Close-Run profit target.  ForexGM will close the Run
when that target is reached.  If CR Include Closed Trades Net is set true, the profit calculation includes all trades
closed within that specific grid Run.  During trading, the continuously updated Net Profit/Loss figure is displayed in
the chart comments.  This figure is calculated independently from all other trades that might have been placed
during the period in  question,  whether they were  placed by ForexGM, other  robots,  or manually.   Unique EA
Numbers are used to identify trades that relate to a specific ForexGM instance.  This setting can be changed on-
the-fly, although it can trigger an immediate Close-Run if a profit target has been reached at the time the change is
made.

CR Total Loss Percent:
If set to 0, this input is ignored.  If non-zero, it will trigger a Close-Run when the net loss of all open and closed

trades within a Run equals the specified percentage of run-start Chart-Equity.  When CR Loss Percent is triggered,
it closes all Grid open trades and deletes all pending orders, and then ForexGM will automatically initiate the next
Run if Auto Restart After Loss is set true.  This setting can be changed on-the-fly, but be aware that it can trigger
an immediate Close-Run if a loss target has been reached at the time the change is made.

CR Trail-Stop Percent [ CR-TSP ]:
When the value is set to the default zero, both this input and the following CR-PPBTSP input are ignored.  A

non-zero value specifies a trail-stop in terms of run-profit  as a percentage of the start-run Chart-Equity.  As an
example, suppose CR Trail-Stop Percent = 1.0% and the start-run Chart-Equity is $4,000.  The trail-stop would be
$40, and the Run would close if the profit fell $40 below the peak profit for the Run.  This setting can be changed
on-the-fly, but it is important to note that it is only applied at the start of a Run and has no effect during a Run. 

CR Profit Percent Before TSP [ CR-PPBTSP ]
This parameter works in conjunction with CR Trail-Stop Percent.  If it is zero, a percent trail-stop is activated

when the Run begins.   If non-zero, the percent trail-stop will  kick in when Run profit reaches the CR-PPBTSP
percentage of the start-run Chart-Equity, and applies until the Run closes.  If CR-PPBTSP = 0.5% as an example,
then equity must increase by 0.5% before the  CR Trail-Stop Percent input is triggered. The profit used in the
calculation is the net profit of all open trades, plus the net profit of trades closed during that specific grid Run (if CR
Include Closed Trades Net is  set  true).   This setting can be changed on-the-fly,  but  as with  CR Trail-Stop
Percent, it is only applied at the start of a Run..        

CR Loss Money:
This setting is very similar to CR Loss Percent except that the trigger-level for a Close-Run is specified as a

monetary amount rather than a percentage of Chart-Equity.  It is useful if a trader wishes to limit the loss on a
particular Run to a certain amount.  It can be changed on-the-fly. 
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CR Trail-Stop Money: [ CR-TSM ]
This setting is very similar to CR Trail-Stop Percent except that when CR Profit Money Before TSM (below) is

set to the default zero, this input is ignored.  It is also ignored if CR Trail-Stop Percent is set because both these
options cannot be active at the same time.  When CR-PMBTSM is set to a monetary value, $3,000 as an example,
this input is enabled.  If CR-TSM = $500, then when profit reaches $3,000, the $500 trail-stop is activated and a
$2,500 profit  is  locked in.   As profit  increases further,  the trail-stop will  trail  dollar-by-dollar (or whatever  base
currency the account uses) – at $3001 a profit  of $2,501 profit  is locked in.  Profit  is calculated for all  orders
associated with the particular grid Run.  This setting can be changed on-the-fly.

CR Profit Money Before TSM: [ CR-PMBTSM ]
When set to the default zero, this parameter and CR Trail-Stop Money are ignored.  It should not be enabled if

CR Trail-Stop Percent is  set.   As illustrated in the previous paragraph, this  setting specifies the trigger-level
(monetary Run-profit value) to be reached before the trail-stop money is activated.  This setting can be changed on-
the-fly.

CR Profit Pips:
If set to the default zero then this input is ignored.  When set to a pips number value (whole pips only, no

fractions), this input specifies the number of pips profit that will cause a Close-Run. For example, if  a strategy has
CR Profit Pips = 150, this means that 150 pips is the Run target.  ForexGM will close the Run when it reaches 150
pips in profit target, and a new Run will start immediately (unless Auto Restart After Profit is disabled).  The 150
pips target is calculated from the net value of all open trades, plus the net profit of trades closed within that specific
Run (except if  CR Include Closed Trades Net is set false, and only the open trades are taken into account).  If
Show Comments is set true, the Net Profit Pips figure is displayed on the chart.  This setting can be changed on-
the-fly.

CR Loss Pips:
If set to the default zero, this input is ignored.  For any positive value, this input results in a Close-Run when the

net pips loss of all open  and closed trades within the Run reaches this level.  However, if  CR Include Closed
Trades Net is set false, and only the open trades are taken into account.  The pip calculation does not include any
trades unrelated to the specific ForexGM instance.  A unique EA Number is assigned to each ForexGM instance to
identify related transactions and trades.  This setting can be changed on-the-fly.

CR Trail-Stop Pips:
If set to default 0 pips, then this setting is ignored.  For any other value, either positive or negative, this setting

specifies the Close-Run price threshold in pips.  When a Run starts, the threshold is set above or below current Bid
price at that time – above the Bid price if a positive number, below if a negative number. As an example, consider a
current EURUSD price of 1.3095 and CR Trail-Stop Pips = 20.  When the price moves down, the stop-loss will
follow it down and remain 20 pips above the Bid price.  As the price retraces and moves upwards, the threshold
remains fixed and a Close-Run is triggered when the price reaches that threshold price level.  If CR Trail-Stop Pips
was negative, the effect would be in the opposite direction, with the threshold adjusted to be 20 pips below the Buy
price for an upward price movement.  Extra care should be taken when combining CR Trail-Stop Pips with any of
the Auto-Restart options.  This setting can be changed on-the-fly.

CR Price Maximum:
CR Price Minimum:

These two inputs can be set independently, and are ignored if set to the default zero.  Set to a specific price
above or below the prevailing Bid price as appropriate, a Close-Run is actioned when the Bid price hits either
threshold level.  It is important to note that these settings should only be used in a short-term monitoring situation,
and manual intervention is required before the following Run can commence.  They should NEVER be used in
conjunction with any Auto-Restart options as the results could be unpredictable, and potentially disastrous. This
setting can be changed on-the-fly.
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IMMEDIATE-CLOSE OPTIONS

These settings are used to immediately close some of or all trade orders controlled by this instance of ForexGM
and its  EA Number.  A close procedure is actioned as soon as one of these options is selected in the Settings
Panel and the OK button is clicked.  To resume trading after the trades have closed, it is necessary to return to the
Settings Panel and deselect the previous close-option.  A Red text-box displays a message on the top-right of the
chart as a constant reminder that ForexGM requires a reset before normal trading resumes.  Settings in this section
specify which particular grid-orders should be closed, resulting in either a full or partial Close-Run.

A full Close-Run occurs when the chosen options result in the closure of all  trades and pending orders.  A
colored rectangle (the Close-Run marker) is drawn on the chart to identify a full Close-Run, and the upper and
lower boundaries will usually correspond to the highest and lowest prices of trades placed within the Run.  Hovering
over this marker will show the equity and profit/loss associated with the Run.  Full Close-Runs are numbered 1, 2, 3
etc.  For partial Close-Runs, letters are appended to the run-numbers… 1-A, 1-B, 1-C, etc. 

It  is  important  to exercise caution for partial  Run-Closes when  Grid Order Replacement is  set  true.   The
situation might arise where an order is deleted, and is immediately replaced when the grid becomes active again.
These settings apply only at the time ForexGM is restarted via the Settings Panel, and hence can be changed on-
the-fly.

Trades can be closed using various techniques available in the MetaTrader terminal, but note that if trades are
closed outside the control of ForexGM, the accounting data will no longer be reliable.

Close Greater-Profit-Than:
Close Greater-Loss-Than:

These settings are only enabled when set to a positive, non-zero value, and Close Orders Now = Close-At-
Specified-Profit-Loss.  As an example, if Close Greater-Loss-Than is set to 100 and the base account currency
is USD, only trades showing a loss of US$100 or more will be closed.

Close Orders-Type:  ( Buys-and-Sells, Buys-Only, Sells-Only )
As with the previous parameter, this works in conjunction with the  Close Orders Now option.  If set to the

default  Buys-and-Sells, all order types will be included when assessing the criteria to determine which trades to
close.  Somewhat expectedly, if Sells-Only is selected it means only Sell trades would be included. 

Close Orders Now:  ( default = Close_None )
Close-None – Continue trading as normal
Delete-Pending – Only delete Pending Orders
Close-Trades – Close Open Trades
Close-At-Specified-Profit-Loss – Close trades that have profit/loss outside the limits (above)
Close-Run-Now – Close all trades matching the Close Grid-Type and Close Orders-Type criteria 

If Delete-Pending is set, be aware that no new pending orders will be placed until after the next full Close-Run.

©2018  Forex Grid Master – ForexGridMaster.com   All rights reserved Page 18 of 26

https://forexgridmaster.com/


Fixed-Center and Moving-Center Scenarios

Fixed-Center Grid

Figure #1:  This image illustrates a Fixed-Center grid run in Strategy Tester with the settings below.  The equity
graph is also included to demonstrate a useful technique for comparing the profitability of various strategies.

Grid Type Fixed-Center-Grid

Order Type Buy-Sell

Trend Direction Counter-Trend

Grid Spacing 5

Max Pending Buy Orders 1

Max Pending Sell Orders 1

Center-Zone Pips 0

Take-Profit Pips 0

Stop-Loss Pips 0

Trail-Stop Pips 3

Profit Pips Before TS 16

CR Trail-Stop Percent 0.15

CR Profit Percent Before TSP 0.80

As the price moves out from the fixed center-line, Sell-Limit and Buy-Limit orders are placed and opened when
the prices reach the appropriate levels.  With these settings, only one pending order is placed in each direction.
Individual trades are closed by the Trail-Stops.  The Run will close once the profit has reached the target 0.80% of
Chart-Equity (or more) followed by a drop of 0.15% from that threshold.
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Moving-Center Grid

Figure #2:  This image shows snapshots at three different positions along the time-line to illustrate how the moving
center is adjusted as price moves, and keeps orders outside the excluded center-zone.

The following settings were used to produce the result shown.  The best way to understand how the Moving-
Center works is to use settings similar to these and run a test or two in the Strategy Tester.

Grid Type Moving-Center-Grid

Order Type Buy-Sell

Trend Direction Counter-Trend

Grid Spacing 10

Max Pending Buy Orders 2

Max Pending Sell Orders 2

Center-Zone Pips 30

Take-Profit Pips 30

Stop-Loss Pips 10

In section 1 of Figure #2, the Buy and Sell pending orders are placed symmetrically around the center-line price
set when the Run started.  The dull-red band is an indication that the Center-Zone extends 15 pips either side of the
center-line where orders cannot be placed.  As the price moves down in section #2, a Buy is opened at the Buy-
Limit.  This does not change the center-line or trigger adjustment of other grid orders.  However, the price turns
back up and closes this Buy trade on a Take-Profit target.  This leaves a gap between the lowest Sell-Limit and the
highest Buy-Limit of 40 pips, i.e. greater than the 30 pips set for Center-Zone.  To correct the situation, the top Sell-
Limit is relocated as close as possible to the current Bid price resulting in a shift downwards of the center-line.

In section #3, the price continues its upwards movement, opening Sells and adding Sell-Limits along the way.  In
the lower portion of the grid, Buy trades are being closed at Take-Profit targets and new Buy-Limits added as
appropriate.  The end result is that the center-line moves roughly in sync with the currency-pair price.
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Grid Runs... The Magic at the Heart of ForexGridMaster
When ForexGridMaster is initiated on a chart, no matter what the preset-file strategy settings are, grid Run #1

starts and pending orders are placed on the broker’s MetaTrader4 server according to those settings chosen by
trader.

The philosophy that drives ForexGM is to break trading into blocks of trades, or Runs.  A Run will close all trades
and delete all pending orders when certain criteria have been met.  These Run-Closes are controlled by carefully
configured parameters  that  should  produce the various  desired  outcomes – profit-targets,  loss-limits,  hedging,
restart-delays, spike-response, and others as detailed in earlier sections.

Successful Forex trading relies heavily on visual aspects of the trading-terminal to help identify endless patterns
in price movements that could lead to profitability.  ForexGM extends the graphics built into MetaTrader4, with the
aim of placing graphics in a meaningful context to convey the maximum amount of useful information.  Spike-
detection is one area where we have pushed the graphic 'envelope' to its limit.  We also recognize the importance
of back-testing various strategies before committing funds.   The following screen-shot from a Strategy Tester Run
illustrates how the Runs are marked on  a chart,  plus a few visual  cues as the what might  have caused the
particular Run to close.

Figure #3:  In this particularly busy screen-shot, we have attempted to capture several of the graphical features that
are unique to ForexGM.  The Green rectangles mark the end of a Run.  Those shown here are colored Green
because the three Runs were all closed in profit.  If a Run is closed in loss, the rectangle would be Red.  If desired,
these default colors can be changed by setting values in the Profile.  Hovering over the bars above and below the
rectangles will display tooltips giving details about the associated Run.

A small icon is added to indicate where pending-orders are actually opened.  In Strategy Tester, this feature is not
of much benefit because the point pending-orders are opened is already marked with a small arrow.  However, in
Demo or Live mode, no arrow is drawn to indicate the opening of an order, so the additional icons can be extremely
useful.  Blue icons indicate Buy orders, and red for Sells.  The strategy illustrated has a Main-Grid with Fixed-
Center, which produces the horizontal blue lines marking grid center-price and the outer grid-slots that would be
occupied if the maximum number of grid positions were filled.  There are several other situations that result in
horizontal lines to indicate various significant price levels.  Hover over any line and the tooltip should identify its
function. 
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Profile ForexGM_Express.prf –  Alerts, Objects, Chart Display
The ForexGM_Express.prf  file is optional, and to take effect it should be placed in both these folders -- “[MT4

Data Folder]\MQL4\Files” and “[MT4 Data Folder]\tester\files”.  ForexGM can run with the ForexGM_Express.prf file
using  its  default values,  but  there  are  many  settings  that  might  be  customized  to  suit  personal  preferences.
Changes made to these prf files affect all instances of ForexGM running in a terminal.  Note that the Strategy Tester
profile is separate from the profile in the normal run environment.  Any new ForexGM instance will automatically
adopt the appropriate profile once it is set up.

Some options allow an email  to be sent  when an Alert  is  triggered.   This  requires additional MetaTrader4
terminal configuration.  In the menu, Select Tools > Options > Email, and enter the required details.  Only one email
address can be used and this applies for all Alerts sent from ForexGM.  If you wish to customize the sounds for
various Alerts,  load the required sound-files into the  [MT4 Data Folder]\Sounds folder and modify the relevant
references in the Profile.

The following fields are typical entries in ForexGM_Express.prf.  Please take care to include the semi-colon (“;”)
at the end of each line and before any comment delimiter (“//”).  If the value of any field is set “default”, ForexGM will
use the relevant default value built into the software.  Some fields appear in the Settings as well as in the Profile.  In
this case, any non-default value in Settings will take precedence over the value in the Profile.  

 Fields referring to colors can use any of the following formats...

Web-color Names: clrMediumBlue
Hex Format: 0x665544 ( 0xBBGGR )
RGB Format: 20,30,40   ( rr,gg,bb )

ShowComments = default;
TextSize = 9;
TextColor = clrYellow;

ChartBackgroundDark = true;
There  are  two  default  styles  built  into  ForexGM  –  one  with  a  light-coloured  theme,  the  other  dark.
Experiment with this field set to 'false' if you prefer a light background.

CenterLineColor = clrSteelBlue;
CenterZoneColor = default;
TrailPriceColor = default;
CloseBarInitialColor = default;
CloseBarPartialColor = 85,85,143;
CloseBarProfitColor = default;
CloseBarLossColor = default;

LogActivity = true;
LogDebugInfo = default;

AfterMarginLimitResume = true;
When there is  a Margin-Call  on an Account,  ForexGM pauses.   With this  field set  true,  ForexGM will
continue trading if  the Account Equity increases so that  the Margin is again within limits.  If  set  false,
ForexGM will need manual intervention for trading to continue after a Margin-Call has been triggered.

TestCommission = 0.00;
This parameter simulates Commission when using the Strategy Tester.  A value of 7.00 would represent a
return-trip Commission of 7.00 units of Account Currency per lot.

AccountNameTester = Joe Trader;
If the MetaTrader4 Terminal is disconnected from the broker, it is often difficult to obtain the Account-Name.
This name is required for ForexGM licensing.  In order to use the Strategy Tester in off-line mode, enter the
full name of the account in this field.

©2018  Forex Grid Master – ForexGridMaster.com   All rights reserved Page 22 of 26

https://forexgridmaster.com/


Alerts related to parameters in the following group will fire every time the particular trigger-event occurs.

AlertRunClosedSound = true;
AlertRunClosedPopup = false;
AlertRunClosedEmail = false;
AlertSpikeSound = true;
AlertSpikePopup = false;
AlertSpikeEmail = false;

The following three fields will produce an Alert only once when the trigger event first occurs, and will be reset to
fire again after the MetaTrader terminal is restarted or ForexGM is reloaded.

AlertMarginWarningSound = true;
AlertMarginWarningPopup = false;
AlertMarginWarningEmail = false;

A zero value for any of the following parameters will disable the particular Alert.  Each of the Alerts in this group
will only fire once per Run.  Additionally, these Alerts will be reset whenever the EA or terminal is restarted.  Note
that any change of  chart-period will also cause a reset of these Alerts.

AlertTotalBuysOpenSound = 0;  // ( set the total number of Buys that will trigger Alert )
AlertTotalBuysOpenPopup = 0;
AlertTotalBuysOpenEmail = 0;
AlertTotalSellsOpenSound = 0;  // ( set the total number of Sells that will trigger Alert )
AlertTotalSellsOpenPopup = 0;
AlertTotalSellsOpenEmail = 0;

For each Alert involving Sound, the following fields can be used to customise the sounds related to each event.

SoundInputError = expert.wav;
SoundRunClosed = alert2.wav;
SoundSpike = alert.wav;
SoundBuysOpen = alert.wav;
SoundSellsOpen = alert.wav;
SoundMarginWarning = alert.wav;
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ForexGM  Chart Comments
An example in Strategy Tester …

Figure #4:  Chart Comments are completely dynamic and refreshed every tick.  Some lines display only when
certain  parameters  are  set,  for  example  the  Profit-Percent/Trail-Stop  comment-line  shown  above.   In  certain
situations,  a  line  might  be  highlighted  or  displayed  in  bold-font.   Taking  Profit-Percent/Trail-Stop  again  as  an
example, when the threshold ProfitPercent BTS is reached, the related comment-line is drawn in bold-font and the
new threshold value is updated if pushed higher.

Strategy:  A free-form entry copied from the Settings-field that identifies set-file name and function
Details:  Another free-form field  that could be used to display extra information about a strategy
Account Equity/Chart Equity:  Displays the split between Account-Equity and Chart-Equity
Account Details at Run 1 Start:  Original starting Chart-Equity plus date and time
Net Profit Preceding Runs:  Total Profit/Loss for previous Runs (money and percent) – useful for analysis
Current Run Start Equity:  Chart-Equity plus Date and Time at the start of the current Run
Current Run Net Profit:  Profit/Loss (money and percent) of current Run – updated tick-by-tick 
Drawdown:  Maximum drawdown (money and percent) over all Runs, plus Date and Time of drawdown
Minimum Chart Equity / Margin Level:  Displays in Strategy Tester to facilitate risk assessment
Profit Percent BTS:  Details displayed if CR Trail-Stop Percent and CR Profit Percent Before TSP set
Loss Limit:  Displays the Loss Limit (money and percent) if CR Loss Percent is set
Grid  Buys/Sells:  When the grid  is  active,  this  line displays  the number of  open Buy and Sell  trades
associated with the grid, and the total lot-size for each order-type
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Testing and Problem Solving
When ForexGridMaster fails to function as you expect, it's time to investigate if your expectations are correctly

aligned with the product, or whether a bug exists in the system that should be brought to the attention of our
developers.  First step is to carefully check the settings in the Properties Panel to ensure all inputs are properly
configured and compatible with each other.  No effort has been spared in preparing this manual to explain the
subtleties and finer points of ForexGM, so please make good use of it.

By default, ForexGM specific error-messages are written to the log-file accessible through the “Experts” tab.
Errors  related to  broker  communication or  transaction  processing  usually  appear  in  the  “Journal”  tab.   In  the
MetaTrader4 terminal, both these tabs are displayed below the chart window when the control-panel is visible.  A
new log file is created each day, and there are various techniques for retrieving information from earlier logs –
please check the MT4 help files for details.

Some problems occurring in software (and hardware) might never be resolved because the problems cannot be
reliably  reproduced.   When reporting a  problem with  ForexGM,  please make every effort  to  provide sufficient
information  for us to recreate the problem.  The level of debug information collected by ForexGM is controlled by
the Log-Activity and Log-DebugInfo entries in both the Profile (prf file) and the Settings.  The Settings related to a
particular ForexGM instance take priority over any parameters in the Profile, so set both these parameters to 'true'
in the Properties Panel to output all information that might provide clues in tracking down possible bugs.

Here is a broad checklist of steps to follow when you wish to report an ForexGM problem to Support...   

Close all open and pending trade orders --  either close manually or use the Close-All-Now option 
Remove ForexGM Express --  right-click on the chart  Popup > Expert Advisors > Remove
Delete all Global Variables -- Go to menu  Tools > Global Variables > Select all > Delete.
Delete all Objects from the chart --  right-click on chart  Popup > Objects List > Select all > Delete
Close the MetaTrader4 terminal
Restart the MetaTrader4 terminal
Load ForexGM on the chart -- drag-n-drop ForexGM from the Navigator Panel, or select chart and double-
click ForexGM
Configure the settings you want in ForexGM Properties Panel > Inputs tab, consult the manual for settings
info
In Properties Panel click Save and name/save the preset-file, usually to [MT4 Data Folder]\MQL4\Presets\
Click OK to activate ForexGM Express

If ForexGM Express still does not operate the way you expect, please do this ...

Send us the related preset-file previously saved to the [MT4 Data Folder]\MQL4\Presets\  folder
Send us the relevant Experts log-file from [MT4 Data Folder]\MQL4\Logs\
If the problem is visible on the chart, go to main menu  File > Save as Picture… > Active Chart (as is)
Describe what happened as best you can, and also provide the appropriate information listed below
 

The above procedure solves 95% of all reported ForexGM problems.  Some of the remaining 5% could be due a 
corrupted MT4 program (not because of ForexGM), and this is usually fixed by a re-install of the MT4 software.

Please provide some or all (if appropriate) of the following information when reporting a problem to us …

Name of Broker
Account Type -- Micro, Mini or Standard account
Account Leverage -- 100:1, 200:1, 500:1, etc.
Run Environment -- Back-testing in Strategy Tester; Live or Demo account
Account Balance, Account Equity and Margin level
MetaTrader4 Release and Build Number ( see main menu  Help > About... )
Does ForexGM show a smiley-face, and is it red?
Is the problem related to a specific time-frame?  If so, which one?
Are there other instances of ForexGM or other EAs trading on the same terminal?  If so, details please
Attach the relevant preset “.set” file/s --  these are most important as they allow us to recreate the problem
Attach Experts and Journal log-files, or copy/paste relevant sections into the email.
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Edit the Settings and set Log-Activity = true and Log-DebugInfo = true, and run the strategy again to see
if more details can be obtained about the problem.  If the log-files show additional information related to the
problem, please include this latest log with the problem-report you submit to us.
If appropriate, include a copy of the Account Statement accessed from the “History” tab on the control-panel
at the bottom of the terminal.  Right click in the History entries, select the reporting-period, and then choose
“Save as Detailed Report”.
It might also help in diagnosing the problem to send us an image of the chart running ForexGM at the time
the problem occurred.  From the main menu… File > Save As Picture…
Please be thorough and include any additional information that might be helpful

ALL TRADING INVOLVES RISK OF LOSS  Trading in the Off-Exchange Retail  Foreign Currency Market
(FOREX) can be one of the riskiest forms of investment in the financial  markets due to the high leverage
provided by most brokers, and therefore is best suited for sophisticated individuals and institutions.  Because of
the potential to lose all funds invested, one should never invest money that one cannot afford to lose.

Nothing in this document is a recommendation to buy or sell currencies, and no ForexGridMaster employees or
associates are liable for any loss or damage, including without limitation, any loss of profit or funds invested,
which may arise directly or indirectly from the use of ForexGridMaster such as, but not limited to… trading-
robots, tools, information, etc. or reliance on such information.

Past performance does not guarantee future results, and this refers also to all past performance illustrated on
the ForexGridMaster  web-site.   Every investor  should  seek professional  advice regarding the suitability  of
ForexGridMaster for the investor's personal needs and circumstances.
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